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This document is a training manual for new users of Real-Time FSA.  It provides instructions for 

accessing the FSA reports and explains how to interpret the information displayed in these 

reports. 

Introduction 

Real-time FSA (RT-FSA) is a web based application that allows you to monitor traffic 

management initiatives (TMIs) as they are executing. 

FSA generates twelve different types of reports: Performance, Flight Status, Adaptive 

Compression, Cancels That Flew, Compliance, CTD Before PGTD, Pop-Ups, Pop-Ups Delay, 

Time Out Delay, Duplicate Flights, Unassigned Slots, and Events. These reports are updated 

every five minutes with the most current Airport Demand List (ADL) information. 

The information provided in these reports helps you identify problems as they occur, so that you 

can correct problems that impact TMI performance. 

The new format for the FSA home page displays whether individual events within a TMI are 

active or inactive. RT-FSA updates events to inactive when one of the following occurs: 

1. Purge — all active events become inactive. 

2. The event is no longer controlling any flights. 

3. Another (actual) event is issued (Airspace Flow Program (AFP), GDP, COMP, and 

Blanket only). A GS becomes inactive only if it is purged or is no longer controlling 

flights. 

It is possible to have both a GDP event such as a revision and a GS executed within the GDP 

active at the same time, if the GS did not encompass all flights in the GDP. 

If a GS is active but a GDP has not been issued, only two reports are available:  the Compliance 

report, and the Events report. If a GDP is active at the same time as the GS, all reports are 

available. 

Accessing the Reports 

The reports are viewed using an internet browser. To access the reports: 

1. Start your browser. 

2. Go to the ATCSCC homepage   

3. Click the Operational Information System (OIS) link. 

4. Click the FSA link on the bottom of the left hand side menu on the OIS page. 

Note: A GS cannot be issued for an airspace element. 
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Figure 1: RT-FSA Home Page 

The FSA home page shown above has a link for each airport or airspace element that has a TMI. 

Each initiative within an event is sorted by its report time. When you click on a link for an airport 

or airspace element, RT-FSA displays the Performance report for the selected airport or airspace 

element. You can access all other reports from the Performance report. 

Table 1: Current Initiative Statuses 

Symbol Status Description 

 Adaptive Compression ON The last reported AC ―status update‖appears as 

"[HHMM] Adaptive Compression (# ADPT / # 

ABRG)‖. For example; 1615 Adaptive 

Compression (3 ADPT / 5 ABRG)" where HHMM 

is the last ADL time received for the AC. The 

ADPT number is the number of flights that 

received AC. If no flights were bridged but there 

was a compression ‗0‘ would appear for ABRG. 

Applicable only to AFP and GDP. If the symbol 

appears but the phrase "No Adaptive Compression 

Reported" appears, then AC is ON but the event 

has not occurred yet. 

 Adaptive Compression OFF AC is turned OFF for the element. Applicable only 

to AFP and GDP. 

 ALL OFF AC and substitution processing for the element 
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have been turned OFF. Applicable only to AFP 

and GDP. 

 Event Controlling Flights TMI is controlling flights in the element. 

 Event NOT Controlling 

Flights 

TMI is no longer controlling flights in the element. 

Links are also available for cancelled TMIs from the current day. The reports for the cancelled 

TMIs are accessed in the same manner. 

Performance Report 

The Performance Report shows whether the program is delivering the requested Program Rate 

(see Figure 2). 

For each program hour, the report displays the program rate, number of slots, number of 

cancellations, extra demand, displaced demand, and the total demand expected. These counts are 

the key to understanding why the program is over or under delivering for a particular hour. An 

explanation of each count appears below. 

Program Rate: The rate is populated with data from the table PARAMS_PROGRAM_RATES. 

The rate shown will be pro-rated for partial hours at the beginning of the program. The rate will 

also be prorated if it changed in the middle of an hour due to a revision. 

Number of Assigned Slots: The number of slots FSM created for that hour. Sometimes the 

number of slots does not equal the requested program rate due to a number of factors. See 

Appendix A for further explanation. 

Flights Controlled By Another Initiative: The number of flights passing through the current FCA 

that another TMI controls. These flights have a ―CTL_ELEM‖ value that is different than the 

current FCA for which the AFP was created. This number is positive. 

Cancellations:  The number of cancelled flights in the hour. This number equals the number of 

squares on the FSM timeline for the hour. The number is always a negative number. 

Pop-Up Demand – Unassigned: The total number of pop-up flights that are assigned to 

unassigned slots for a UDP or a GAAP program. Clicking on the number of flights under ―Pop-

Up Demand – Unassigned‖ for each hour, will display a new report that displays the flight call 

signs, their delay, average delay, and total delay for all the pop-ups that were assigned to 

unassigned slots under an UDP or a GAAP program.  

Pop-Up Demand – DAS: The total number of pop-up flights that are assigned to DAS type slots 

for a UDP or a GAAP program. Clicking on the number of flights under ―Pop-Up Demand – 

DAS‖ for each hour, will display a new report that displays the flight call signs, their delay, 

average delay, and total delay for all the pop-ups that were assigned to DAS type slots under an 

UDP or a GAAP program.  

Extra Demand: The number of extra flights showing up in the hour that do not have an FSM 

assigned slot in the hour. This number is the sum of those flights with a Z slot in the hour being 

reported on and those flights whose ETA has shifted into the hour being reported on. A Z slot is a 

Note: The RT-FSA System displays all cancellations of flights with 

slots for each hour of the TMI on the Cancellations Row. 
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virtual slot assigned by FSM to pop-up flights for sorting purposes. The extra demand is typically 

due to pop-ups, flights that should have shown up in an earlier hour (they have a slot time prior to 

the hour), or flights that should be showing up in a later hour (they have a slot time in a later 

hour). Occasionally extra demand may be due to "Non-program" flights. These are flights that 

were not originally given a slot by FSM because they were not expected to arrive during the 

program hours. For instance, flights may delay into the first hour of the program after the initial 

program is run. 

Arriving Prior to Control Hour:  The number of flights which should have shown up in the hour 

(they have slot times in the hour), but are expected to arrive in an earlier hour due to an early 

departure or some other reason. 

Arriving After Control Hour:  The number of flights which should have shown up in the hour 

(they have slot times in the hour) but are expected to arrive in a later hour due to a late departure 

or some other reason. 

Total Current Demand:  The total number of flights expected to arrive in the hour at the ADL 

time shown at the top of the report. The Total Current Demand for an hour equals the number of 

slots allocated minus the ―No-shows‖ (i.e. the Cancellations and flights Arriving Prior to and 

After Their Control Hour) plus the extra flights arriving in the hour that do not have slots in the 

hour (i.e. the Extra Demand). 

Number of Unassigned Slots: The total number of Unassigned Slots for a GDP or an AFP event 

with a GAAP or UDP delay. If a 0 appears in the place of the number, then the GDP or AFP has a 

DAS delay not a GAAP delay. Clicking on the number causes a list of Unassigned Slots for the 

appropriate hour to appear and displays it underneath the Performance report. When no 

Unassigned Slots exist for a particular hour, ―NO FLIGHTS‖ appears under the Performance 

Report.  

Total Potential Demand: The sum of the Total Current Demand row and the Number of 

Unassigned Slots row for each hour. Clicking on the number generates a combination of the 

unassigned slot list and the total current demand list for the appropriate hour and displays it 

underneath the Performance report. 

Drop Outs: The number of flights that have rerouted out of an AFP. This number is positive. 

Clicking on the number generates a flight list of drop out flights for the appropriate hour and 

displays it underneath the Performance report. 
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Figure 2: Performance Report 

Ground Stop Only 

Since there is no FSM Program rate associated with a GS, it is not possible to generate the 

performance report. The compliance report shows all non-compliant GS flights for all active 

ground stops at the airport being viewed. 

Drill Down Capabilities 

Click on the associated link to view the flights comprising each count. Figure 3 below shows the 

result of clicking on the Extra Demand Link for the 2300 hour. The resulting flight list shows all 

of the aircraft that are expected to arrive in the 2300 hour that do not have FSM assigned slots in 

this hour. 

 

Note:  For airline users, general aviation and military flights do not 

appear, so the number of flights appearing in the report may be less 

than the count shown in the performance table. 
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Figure 3: Extra Demand 

The ―Comments‖ column in the flight list provides an indication of why a flight either does not 

have a slot or is not arriving at its assigned slot time. See Table 1 on pages 10-11 for a complete 

list of the comments that may appear in the ―Comments‖ field. 

Accessing a Flight’s History 

Clicking on a call sign in the flight list displays all the flight data received through the ADLs for 

the flight selected.  

Sorting 

By default RT-FSA sorts the flight lists displayed on the performance report by Slot Time. Click 

on any of the underlined column titles to re-sort the flight list by the column selected. 

Usage 

Determining why there is over or under delivery 

The counts in combination with the comments in the drill down flight lists show why an hour is 

heavy or light. For example, if 3 additional flights are expected to arrive in the 2100 hour that do 

not have slots in this hour. The comments for these flights might reveal that the extra demand is 

Note:  Sorting by the Entry column title causes the Slot Time column 

title to rename to Entry Hour. Sorting by the ETA column title causes 

the Slot Time column title to rename to Arrival Hour. 
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due to 2 flights that were supposed to arrive in the 2000 hour that are no longer expected to arrive 

in this hour due to errors in ETE estimation and, for 1 flight, a time out delay into the 2100 hour. 

If no flights have been cancelled and -1 flight is arriving prior to its controlled time, then the net 

balance (i.e. the total demand) is 57 flights – 2 flights more than the requested program rate of 55. 

Determining whether a compression or revision is needed 

You can use the information provided in the Performance Report to determine whether an event 

needs a compression or revision. To determine if you need to take any action and what type of 

action is most appropriate, compare the requested Program Rate to the Num. Of Slots and the 

Total Demand for future hours, as described below. 

No Action Required 

If the Total Demand = Program Rate, Cancellations=0, and there has been very little shift in 

demand, no action should be necessary. The demand graph in FSM appears "smooth" and the 

FSM timeline has very few triangles and no squares. 

Compression Only 

If the Total Demand <> Program Rate, but the Number of Slots=Program Rate, and there is no 

pop-up traffic then a compression should suffice. RT-FSA lists pop-ups that do not have a slot at 

the top of each hour in the Extra Demand flight lists. To view the Extra Demand flight list for an 

hour, click on the Extra Demand count for that hour. The Pop-Up report also shows the amount 

of pop-up traffic expected in each hour. 

RBS++ 

If Total Demand <> Program Rate, and Number of Slots <> Program Rate, or there is a 

significant amount of pop-up traffic, then the event needs a revision. 

GDP Modeling 

The Performance report shows the impact of GDP actions/modeling choices. For example, after a 

GS is issued, the number of slots assigned per hour no longer equals the Program Rate. Issuing a 

GS redistributes the arrival slots based on the GS release time - not the Program Rate. Issuing 

EDCT updates and adjusting GDPs by ―Blanket‖ amounts of time also moves arrival slots and 

may cause the number of slots to differ from the Program Rate. 

The presence of large negative ETE fluctuations (see the comments provided in the flight lists) 

may indicate a lack of slot availability when a large number of flights are exempted in RBS++. 

See the Program Events report to determine how many flights were exempted for a particular 

event. This report displays the total number of flights included in each program event as well as 

the number of flights affected. The difference between these two numbers equals the number of 

exempt flights for that event. 

AFP Modeling 

The Performance report shows the impact of AFP actions/modeling choices. See the Program 

Events report to determine how many flights were exempted for a particular event. This report 

displays the total number of flights included in each program event as well as the number of 

Note:  The number of “Flights Arriving Before Their Control Hour” 

and the number of “Flights Arriving After Their Control Hour” show 

the degree to which demand has shifted. 
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flights affected. The difference between these two numbers equals the number of exempt flights 

for that event. 

Detecting Airborne Holding 

Large positive ETE fluctuations for flights that have already departed may be an indication of 

airborne holding (see the comments provided in the flight lists). 

Flight Status Report 

For GDP, AFP and GS programs: The Flight Status report shows the current status of all program 

flights arriving within the program and any flight arriving outside of the program with a GDP 

control, AFP control, or GS control. To locate an individual flight, click on the Lookup Flight 

link to search for the flight by its ACID, ORIG, and DEST of a present or past day. By default 

RT-FSA sorts the Flight Status report by ETA in descending order for GDPs and by ENTRY in 

descending order for AFPs. Click on any of the underlined column titles to sort by the selected 

column. 

 

Figure 4: Flight Status Report 

For airspace elements (e.g., FCAs) Entry time is used instead of ETA since ETA is not applicable 

to an airspace element. The Entry time is the time at which a flight enters an airspace element‘s 

boundaries.  

Note: When you sort by Entry Time for an airspace element (FCA), 

the Arrival Hour column header changes to Entry Hour. Also, when 

you sort by Exit Time for an airspace element (FCA), the Arrival 

Hour column header changes to Exit Hour. 



Doc ID:  FSA-SYS-TRN-001 Document Version 8.2 Date:  November 2010   

 
12 

The Comments column indicates why a flight is not arriving at its designated arrival slot. Table 1 

below describes each of the comments that may appear in the Comments field. 

Table 1: FSA Comments 

Comment Description 

Early Departure The flight departed early.  This comment appears if ETD – CTD <= -1.  

Late Departure The flight departed late. The comment appears if ETD – CTD  => 1.  

Airline Delay The delay reported by the airline as indicated by the LRTD field. This 

calculation is measuring reported airline delay in excess of the 

currently assigned ATC delay. Additionally, for departed flights RT-

FSA only counts delay that was incurred. Therefore, if the CTD was 

1300, the LRTD was 1330 but the ETD at departure was 1315 then the 

reported airline delay is 15 minutes. Note: airline delay also is reflected in 

the Late Departure calculation when the LRTD (and actual ETD) exceeds 

the current CTD. 

Time-out Delay  The flight was time out delayed by ETMS‘s timeout. International flights 

are excluded since DZ messages typically are not received for 

international flights. Note:  FSM does not use the TOD flag to determine 

if a flight is in time out delay. Instead, FSM considers a flight to be in 

timeout delay if the current ETD<ADL time. Thus, FSM and RT-FSA 

may not always show the same flights as being timeout delayed. 

Subbed With 

Window 

The flight‘s CTA is not equal to its Slot Time due to airline subbing that 

took advantage of the 20-minute window. Note: the difference between 

the slot time and CTA could actually be greater than 20 minutes due to 

multiple subs. 

ETE Fluctuation The current ETE, which is (ETA-ETD), does not equal the en-route time 

reflected in the current control times (CTA -CTD). The minutes displayed 

after this comment are equal to the difference (ETA-ETD) - (CTA-CTD). 

Exempt The flight was exempt when initially controlled and has remained exempt 

(i.e., the Exempt flag =Y for all flight records that have control times). 

Data Anomaly FSA has detected a data abnormality that indicates a data processing error 

has occurred. 

Flights with a Data Anomaly are omitted from the Compliance, Pop-Up, 

CNX That Flew, and Time Out Delay reports. See Appendix B for a 

listing of the data anomalies FSA looks for. 

CNX That Flew A cancelled flight that operated and was not reinstated before departing 

via a FM, FZ, or DZ message. 

Non Program Flight The flight was not originally in the program but is now arriving during the 

program hours due to a delay or early arrival. The following rules are 

used to identify these flights: the flight does not have a slot ID; it has a 

Note: Airspace elements also have an Exit field, the time a flight 

traversed out of the FCA, and CTL_ELEM indicates the type of 

initiative that is currently controlling the flight. 
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SGTA; the (IGTA-Taxi) does not fall within the program hours; however 

the current ETA does fall within the program hours.  

Pop-up The flight does not have a SGTD/SGTA, the pop-up time > program 

model time, and BETA or ETA falls within the program hours. The pop-

up time is the time stamp of the first ADL record received for the flight. 

Diversion Recovery The DV_REC flag is set to Y for the flight. 

Cancelled Shows the type of cancellation and the time of cancellation. If a flight has 

multiple cancellation flags set, only one cancellation reason is shown 

according to the following precedence: 

1. SI – Cancellation submitted by an airline through an SI 

message. 

2. FX – Cancellation submitted by an airline through a CDM 

FX message. 

3. TO – Indicates the flight is currently timeout cancelled by 

ETMS. 

4. RZ – NAS flight plan cancel message. 

5. RS - Internal ETMS message generated when a specialist 

takes an OAG flight out of the database. 

6. DV - Indicates the flight diverted to an alternate destination 

7. DO – Indicates the flight rerouted out of an AFP controlled 

airspace element. 

Reinstated Indicates that a flight has been reinstated after being cancelled. The 

reinstatement time displayed is the first ADL time where the flight 

changed from a cancelled status to a non-cancelled status, either due to 

departure or the receipt of an FM, FZ, and DZ message. 

Duplicate Indicates there may be multiple occurrences of a flight in FSM due to a 

data processing error, such as an ETMS flight mismatch. Some shuttle 

flights may also be flagged as duplicates. 

GAAP Slot Indicates that a pop-up flight has received a GAAP slot assignment. 

Affiliated pop-ups that received a slot but that subsequently cancel 

continue to have the words ‗GAAP slot‘ in the Comments column. 

Unaffiliated pop-ups that received a slot but that subsequently cancel do 

not continue to have the words ‗GAAP slot‘ in the Comments column. 

DAS Delay Indicates that a pop-up flight received a DAS Delay. 

 

Exclusions 

RT-FSA does not display general aviation and military flights for airline users. 

Adaptive Compression Report 

The Adaptive Compression report shows which flights were included in the last Adaptive 

Compression (AC) run for the element. This report is available for both airport and airspace data 

sets. This report applies for GDPs and AFPs and the report link is available from a GDP/AFP 
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element that you have opened to view all available reports. The Adaptive Compression report 

also includes unassigned slots that are adaptively compressed for an UDP or a GAAP program. 

 

Figure 5: Adaptive Compression Report 

The Adaptive Compression report contains the following information. 

 Flights that received AC. 

 Flights that were Bridged. 

 The time that the flight list was generated. 

 The current AC status from the Current Initiatives page, located just underneath 

the report title. 

 The report status. See "Accessing the Reports" for more information on AC 

statuses. 

 An asterisk next to the ACID for a flight that has not yet departed. A space 

appears between the status indicator line and this line for flights that have yet to 

depart. 

The Adaptive Compression Report groups the Compressed and Bridged flights by descending 

ADL Time by default. So the most recent ADL Time appears first in the table. You can click on 

the ACID field for each flight list section to see the Flight History for that flight. The sort order 

for the Compressed and Bridged flights tables is by descending order of New Slot.   

The Compressed Flights table shows all flights within the element that received AC. It displays 

the following data for each flight: 

 ADL Time – listed as part of the Compressed Flights section but is actually 

shared by Compressed and Bridged flights. 

 ACID – The flight number. If ―Unassigned‖, ―Prev Slot‖ column will be 

populated for these rows. 

 New CTD – The new control time of departure. 

http://rtfsa:8079/RTFSA/help/accessing_the_reports.htm
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 Previous Slot – The previous ASLOT belonging to the flight prior to the AC (this 

includes the ASLOT Suffix). 

 New Slot – The new ASLOT belonging to the flight after the AC (this includes 

the ASLOT Suffix).  

 Delay Difference – The difference between the Previous Slot field and the New 

Slot field. 

 Cancelled – Set to ―Y‖ if any cancel flags are set. 

The Bridged Flights table shows all flights within the element that were Bridged. It displays the 

following data for each flight: 

 ACID – The flight number 

 Bridge Type – The valid values are U for Unassigned Slot Compression (UBRG) 

and A for Adaptive Slot Compression (ABRG). 

 New CTD – The new control time of departure  

 Previous Slot – The previous ASLOT belonging to the flight prior to the AC (this 

includes the ASLOT Suffix). 

 New Slot – The new ASLOT belonging to the flight after the AC (this includes 

the ASLOT Suffix).  

 Delay Difference – The difference between the Previous Slot field and the New 

Slot field. 

Exclusions 

Does not apply to GS initiatives. 

Cancels That Flew Report 

Overview 

The "Cancels that Flew" report shows all controlled flights that were cancelled then operated 

without being reinstated via a FM, FZ, or FA message. 
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Figure 6: Cancels That Flew 

The Cancel-Reason column shows the most current cancellation reason. If a flight has multiple 

cancellation flags set, only one cancellation reason appears according to the following 

precedence: SI, FX, TO, RZ, RS, RM, DO. 

Usage 

An airline may unintentionally operate a cancelled flight because they are unaware that it was 

cancelled. Typically this occurs when a flight has been timeout cancelled by ETMS. Review the 

cancellation reason for the flights in this report. The presence of flights that operated after time 

out cancelling may indicate the airline is having difficulty keeping their CDM flight data current.  

System gaming can be identified by looking for flights that are cancelled, subbed, and then 

operated at the original slot time. Look to see if any of the ―Cancels that Flew‖ were SI or FX 

cancelled. For those identified, click on the ACID to view the flight history. Review the 

CTL_Type field to see if the flight was subbed. Also check to see if the flight departed at its 

current CTD or the original CTD assigned to the flight prior to being cancelled and subbed. 

Exclusions 

Diversion cancellations are not included in this list. Flights for which FSA has detected a data 

anomaly also are excluded. 

For airline users, general aviation and military flights do not appear. 

Compliance Report 

The compliance flight list shows all flights that did not comply with their assigned controlled 

time of departure regardless of whether they were controlled by a GS, AFP, or GDP when they 

departed. A flight is considered "non-compliant" if it failed to depart within a specified 

―compliance window‖. The CTD column shows the CTD used to measure compliance. For GDP 
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or AFP controlled flights this is always equal to the CTD the flight had at departure. The 

compliance window is the maximum number of minutes a flight may depart prior to its CTD or 

after its CTD and still be considered compliant. Authorized ATCSCC personnel may change the 

compliance window through the Site Administration link on the FSA home page. See Appendix 

C for additional information. 

Currently, FSA uses a (-5, +5) minute compliance window. This means a flight is considered 

non-compliant if it departed early by more than 5 minutes, or it departed late by more than 5 

minutes. By default, RT-FSA sorts the Compliance Flight List by Departure Hour. Click on any 

of the underlined column titles to sort by the selected column. 

 ―GDP‖ appears in the Control Action column if a GDP controls the flight when it 

departs. 

 ―AFP‖ appears in the Control Action column if an AFP controls the flight when it 

departs. 

 ―GS‖ appears in the Control Action column if A GS controls the flight when it 

departs. For GS flights, RT-FSA always shows the CTD used to measure compliance. 

For the logic used for measuring compliance, see below. 

 If an update is issued for a GS flight, RT-FSA shows the update time and uses this 

time to measure compliance. 

 
Figure 7: Compliance Report 
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FCA Arrival Compliance Report 

In the top left-hand corner of the departure Compliance report for an FCA is a link to the FCA 

Arrival Compliance Report. This report displays a list of all AFP impacted flights that are not 

Control Time of Arrival (CTA) compliant. Non-compliance is anything outside of a plus or minus 

five minutes entry window (+/- 5). You can get back to the departure Compliance report by 

clicking on the Compliance link in the left-hand menu bar. 

 
Figure 8: Compliance Report 

When you sort by Entry Time for an airspace element (FCA), the Departure Hour column header 

changes to Entry Hour. 

Compliance Remarks 

The Non-Compliance Reason column on the Compliance report allows you to enter a reason for 

non-compliance. Clicking on a link in the Non-Compliance Reason column displays the 

Compliance Remarks window for the associated flight, as shown in Figure 9. 

Note:  RT-FSA uses the CTD assigned to the flight when it departs to 

measure compliance. 
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Figure 9: Compliance Remarks 

You must fill out all fields displayed on the form prior to clicking Submit. 

To specify a Non-Compliance Reason 

1. Click on the down arrow to display a list of reasons. 

2. Select 1 of 5 possible reasons:  

 Aircraft Operator  

 Equipment 

 TMI 

 Weather 

 Other  
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3. Provide a more detailed explanation of the circumstances which prevented the flight from 

departing in the Comments text area.  

 

4. Click Submit. 

RT-FSA records the following information in the FSA database:  the flight ID, the non-

compliance reason, the comments entered, the current Zulu time, the facility Id, the 

operator initials, and the IP address of the sender. Storing the preceding information 

allows the non-compliance data to be matched back to other flight information in the FSA 

database, for reporting and analysis purposes. 

5. You receive confirmation that the information you provided has been saved. 

The reason entered appears in the compliance report as shown in Figure 10. 

6. If the reason you entered does not appear in the Non-Compliance Column, click on your 

browser‘s reload button. The link should now reflect the last reason entered for the flight. 

Other users will not see the reason entered until the compliance report is reloaded in their 

browser. RT-FSA reports automatically reload every 2 ½ minutes. Any time a user clicks 

on a Non-Compliance Reason link RT-FSA checks to see if any prior information was 

entered for the flight. 

Note: Click on the Help button for a description of each reason.   

Note: For FAA users, the person submitting the information should 

provide his or her Facility ID and operator initials. Airline users should 

enter their three letter carrier abbreviation in the Facility ID textbox. 
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Figure 10: Non-Compliance Reason 

To update the Non-Compliance Reason 

You can not edit information which has been submitted. However, you may provide an 

alternative reason and additional comments. To do so, follow the same procedure described 

above. When you click on the link in the Non-Compliance Reason column, any information 

previously entered for the flight appears at the top of the Compliance Feedback window, as 

depicted in Figure 11 below.  You may select an alternative reason or the same reason as 

previously entered.  Before clicking Submit you must also enter information in the Comments, 

Facility ID, and Operator initials fields.  Once the Submit button is clicked the last reason entered 

will be displayed in the Non-Compliance Reason Column for the associated flight. 
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Figure 11: Original reason appears on Compliance Remarks page. 

Exclusions 

―Cancels that Flew‖ and flights for which FSA has detected a "data anomaly" do not appear in the 

Compliance report. Ground stopped flights that departed prior to receiving a control time and 

international flights are also excluded. Flights that departed, for which no DZ message was 

received, are excluded. The ARTD field is blank for these flights.  

For airline users, non-compliant general aviation and military flights do not appear. 

Usage 

The Compliance Report can be used to identify FAA facilities that are not releasing flights within 

the compliance window as well as airlines that fail to depart within the compliance window. Sort 
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by Dcenter to see if the airports within a particular center are releasing flights early or late. A lack 

of compliance within a particular departure center may indicate the center is trying to deal with 

local traffic management initiatives such as ESP delays or miles-in-trail restrictions. Sorting the 

Compliance report by ACID can help identify airlines that are consistently departing flights early 

or late. However, when looking at airline compliance, keep in mind that late departures may be 

due to departure delays at the origin – not airline delays. 

 

How RT-FSA Measures Compliance 

If a flight is controlled by a GDP or AFP when it departed, compliance is measured using the 

specified compliance window (currently -5, +5). 

If a flight is controlled by a GS when it departed, the flight will be considered compliant if it 

departs after the end time of the GS (ARTD >= CTD from the GS). If an airline subs the GS 

flight and changes the CTD, FSA will still measure compliance based on the CTD assigned by 

the GS, except in the case where the substitution resulted in a CTD outside of the GS parameters.  

In the event that a substitution assigns a control time prior to the start time of a GS or after the 

end time of a GS, compliance will be measured based on the CTD assigned by the substitution 

using a (-5, +5) minute window. If an update or blanket delay is issued for a GS flight, FSA will 

measure compliance based on the update or BLKT time using the current compliance window.   

CTD Before PGTD Report 

Overview 

The CTD before PGTD report shows all flights with a CTD that is earlier than their PGTD and 

have either not departed, or have departed and are non-compliant based on the compliance 

window (see Figure 12 below). A flight appears on this list under one of two conditions- it 

receives a CTD earlier than its PGTD, or a PGTD is submitted after the CTD was assigned and it 

is later than the CTD. If the flight departs and is compliant, the flight is removed from the list. If 

it is non-compliant after departure, it stays on the list. Also, if a program event runs, and the flight 

receives a new CTD that is later than its PGTD, the flight is removed from this report. 

NOTE:  The accuracy of the compliance report can be affected by 

suspension of EDCTs, “white hat” approvals for which an EDCT 

update was not submitted, and ground stops that are not implemented 

using FSM. When any of the preceding events occur, a flight’s CTD is 

not updated in the data; thus, the flight may appear non-compliant. 
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The CTD before PGTD Report is sorted by ETD in descending order (excluding the ETD Prefix). 

Click on any of the underlined column headers to sort by that value. 

 

Figure 12: CTD Before PGTD 

Exclusions 

―Cancels that Flew‖ and flights for which FSA has detected a "data anomaly" do not appear in the 

CTD before PGTD Report. Ground stopped flights that departed prior to receiving a control time 

and international flights also are excluded.  

Pop-up Report 

Overview 

The Pop-Up Report shows all pop-ups arriving (or expected to arrive) during the program hours. 

For the purposes of this report, a pop-up flight is defined as any flight that does not have a 

SGTD/SGTA and did not appear in the ADL data at the time the initial program was modeled. 

This list shows all pop-ups regardless of whether they have subsequently been given a slot in a 

revision. 
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Figure 13: Pop-up Report 

The Pop-up Time column shows the time the flight first appeared in the ADLs. The TOD 

Minutes column indicates whether the flight is currently in time out delay. The Cancel-Status 

column shows whether the flight has been cancelled. If a flight has multiple cancellation flags set, 

only one cancellation reason appears according to the following precedence: SI, FX, TO, RZ, RS, 

RM, DO. The Subbed column indicates whether the flight has ever been subbed by the airline via 

a SI message or simplified sub message. 

By default, RT-FSA sorts the pop-up flight list by the Pop-Up Time. Click on any of the 

underlined column titles to sort by the selected column. 

Exclusions 

Flights for which a data anomaly has been identified do not appear in the pop-up list. 

For airline users, general aviation and military pop-up flights do not appear. 

Note: For airspace elements (i.e., FCAs) Entry time is used instead of 

ETA since ETA is not applicable to an airspace element. The Entry 

time is the time at which a flight enters an airspace element’s 

boundaries. 
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Usage 

The pop-up report shows the unscheduled flights that have been filed since the initial GDP or 

AFP was executed. To see how many pop-ups have been filed since the last revision/extension 

sort the pop-up list by pop-up time and look for flights whose pop-up time is later than the model 

time of the revision/extension.  

Sort the pop-up flight list by ETA (for GDPs) or ENTRY (for AFPs) to determine if the excess 

demand for a particular time period is due to pop-up traffic.   

Sort the pop-up report by ACID to see which carriers are filing pop-up flights. By reviewing the 

Pop-up report on a consistent basis, it may be possible to identify trends such as whether a carrier 

tends to operate the pop-ups it files.   

Review the TOD and Cancel Status columns for pop-up flights that are contributing to the 

―Rolling Spike Problem‖ by time out delaying or time out canceling. If a large number of pop-ups 

are time out canceling, this may indicate there is a problem with duplicate calls signs or that some 

other automation problem is occurring. 

Pop-Up Delay Report 

The Pop-Up Delay Report displays unassigned delay for a flights lead time. Specifically, it 

displays the lead time (in hours, up to 8 hours) and the total number of flights assigned to arrive at 

every hour for the duration of the program.   

 

Figure 14: Pop-Up Delay Report 
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Drill Down Capabilities 

Selecting on a non-zero Hour/Lead Time value in the Pop-up Delay Report will allow a user to 

examine the unassigned delay for flights in a program (UDP or a GAAP program) at a certain 

lead time (how far in advance the flight has become known). The new window is displayed under 

the Pop-up Delay Report and includes ACID, slot type, unassigned slot delay, and Z slot delay. Z 

slot delay is the difference between the original airport parking gate arrival time and the arrival 

slot time given to a controlled flight. It also includes the total and average delay for Unassigned 

Slot Delay and Z Slot Delay for the specific hour and lead time hour. 

 

Figure 15: Pop-Up Delays 

Time Out Delay Report 

The Time Out Delay report lists all flights that are currently in time out delay. 
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Figure 16: TOD Report 

The column labeled Minutes Of TOD shows the total number of minutes the flight has been in 

timeout delay. The Cancel Status column shows whether the flight is currently cancelled as well 

as the time at which it was cancelled. If a flight is reinstated it no longer appears as cancelled in 

this report. 

Note: For airspace elements (i.e., FCAs) Entry time is used instead of 

ETA since ETA is not applicable to an airspace element. The Entry 

time is the time at which a flight enters an airspace element’s 

boundaries. 

By default RT-FSA sorts the report by ETA for GDPs and ENTRY for AFPs. Click on any on the 

underlined column titles to sort by the selected column. 

Exclusions 

Flights for which FSA has detected a data anomaly are not included in the timeout delay flight 

list. International flights are also excluded. 

For airline users, general aviation and military flights do not appear. 

Usage 

The ETMS system timeout delays a flight if it has not departed within 5 minutes of its current 

ETD. Flights may timeout delay for a variety of reasons including delays at the departure airport 

or airline delays. ETMS will timeout cancel flights after they have been in timeout delay for 90 

Note: When you sort by Entry Time for an airspace element (FCA), 

the Arrival Hour column header changes to Entry Hour. 
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minutes with the following exceptions:  if no airline or NAS messages have been received for a 

flight and it is departing from a CONUS or Canadian airport, the flight will be time out cancelled 

10 minutes after the scheduled departure time. Flights that are departing outside of the contiguous 

United States or Canada are not timed out. 

Sort the flight list by ACID to see if a particular carrier has a large number of time-out delayed 

flights. Follow-up with the carrier may be necessary to determine if the carrier intends to operate 

a flight. A large number of timeout cancelled flights for a single carrier may indicate that there is 

a problem with duplicate call signs. Time out delayed flights may also indicate an airline is not 

providing current flight information regarding delays as required by the CDM MOA. A flight will 

not time out delay if the airline submits LRTDs showing the delay via a CDM FM message. By 

reviewing the TOD report on a consistent basis, it may be possible to identify airline or ETMS 

data quality problems.  

Duplicate Flights Report 

The Duplicate Flights Report primarily identifies multiple occurrences of a flight that appear in 

FSM due to data processing errors, such as ETMS flight mismatches. However, some shuttle 

flights may also be flagged as duplicates. The intent of this report is to alert users about flights 

shown in FSM that may not operate. This list might show two flights as duplicates even though 

they are both legitimate flights, such as the case with shuttle flights. RT-FSA identifies possible 

duplicates by looking for flights with the same or similar ACID, origin, destination, initial gate 

time of departure (IGTD), and ETA for GDPs, Entry for AFPs. The list is sorted by ACID. 

Note: For airspace elements (i.e., FCAs) Entry time is used instead of 

ETA since ETA is not applicable to an airspace element. The Entry 

time is the time at which a flight enters an airspace element’s 

boundaries. 

In addition to the existing logic to detect duplicate flights, the following criteria is used: 

1. If two flights have the same ACID, ORIG, DEST, and IGTDs that are within 20 

minutes of each other, consider the flights to be duplicates. 

2. If a duplicate pair both have an ETA_Prefix of A, remove the pair from the list. 

3. If one of the flights in a duplicate pair is dropped from the arrivals data, do not add 

the duplicate pair to the list.  If the flight was dropped after being added to the list, 

remove the duplicate pair from the list.   
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These changes were made to better identify ―demand unlikely to materialize.‖ 

 

Figure 17: Duplicate Flights 

Usage 

The Duplicate Flights Report allows the user to easily see demand that might not materialize. If it 

appears that one particular carrier has a large number of flights listed, it could mean that carrier is 

having a data problem. Like the Time-out Delay report, follow up with a carrier may be needed to 

determine if a flight is going to operate or not. Looking at the ASLOT field allows you to see 

which flights are included in the program. 

Exclusions 

For airline users, general aviation and military flights do not appear. 
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Unassigned Slots Report 

The Unassigned Slots report displays the number of Unassigned Slots for each hour in 15 minute 

time bins and the total number of unassigned slots for each hour. Unassigned slots exist only 

when a GDP or AFP with a delay assignment mode of GAAP or UDP has been issued.  

 
Figure 18: Unassigned Slots Report 

Exclusions 

Only a GDP or AFP event with a GAAP or UDP delay assignment mode can have unassigned 

slots. This report is therefore not relevant for other events. 
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Events Report 

All TMI actions executed through FSM appear on the Events page including RBS++, 

compression, ground stops, and +/- delays. For each action taken, the Events Report displays the 

execution time followed by the event type and the start and end time for event. The Model Time 

and Reflect Time for all events also appear. The Model Time is the ADL time displayed in FSM 

when the event was modeled. The Reflect Time is the ADL time displayed in FSM when the new 

control times first appear in the data. Delay Limit appears for GDPs or AFPs with a GAAP or 

UDP Delay Assignment Mode. Other parameters may also be listed depending on the event type. 

 
Figure 19: Events Report 
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For distance based GDPs several new parameters appear. An example Events report for a Boston 

distance based GDP appears below in Figure 20. Definitions are provided in Table 2. 

 

Figure 20: Exempt By Distance 

 

Table 2: Distance Based GDP Parameters 

Term Definition 

Distance The distance specified in the GDP setup panel in nautical miles. 

Exempt Centers Shows any centers that fall within the distance specified, that are 

exempted from departure delay. 

Non Exempt Centers Shows the centers that fall outside of the distance, but are subject to 

departure delay. 

Exempt Airports Displays the airports that fall within the distance, but are exempted from 

departure delay. 

 

Non Exempt 

Airports 

Shows the airports that are subject to departure delay, that fall outside of 

the distance specified. 

Non Exempt If 

Distance 

This parameter has been added to allow special handling of Canadian 

airports during Distance based GDPs.  Any Canadian airports listed will 
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be included if they fall within the distance specified.  The flights 

departing from these airports will not be exempted from departure delay. 

Flight Lookup 

FSA‘s Flight Lookup feature allows you to query the FSA database for flight information. To 

access the query capabilities select the ―Lookup Flight‖ link from any of the FSA reports. The 

query interface is shown below. 

 
Figure 21: Flight Lookup 

To view the flight history for a particular flight, enter the flight's call sign in the ACID field. At a 

minimum, the ACID field must contain a value. The remaining flight fields are optional. Once the 

search criteria has been entered, click Submit Search Terms. 
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A multiple flight query may be generated by using an asterisk after the three-letter ID. For 

example, to query for all ComAir flights enter the carrier's 3-letter abbreviation and an asterisk as 

shown in Figure 22. Then click Submit Search Terms. 

 
Figure 22: Flight Lookup 
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FSA returns a list of flights as shown in Figure 23. For airline users, general aviation and military 

flights do not appear. Click on the flight‘s ACID to view the ADL records received for a 

particular flight. 

 
Figure 23: Flight Lookup Results 

The Flight History is color-coded to highlight changes in a flight‘s control times as well as data 

anomalies identified by FSA as shown in Figure 24 below. Flight records are sorted in ascending 

order by ADL time. 

The flight history page also provides a direct link to the Volpe DataGate Flight History. Click on 

the ―ETMS DataGate Flight History‖ link at the bottom left of the report (below ACID column) 

to access the Volpe Data Gate Flight History. Clicking on the Data Gate link opens the Volpe 

Data Gate Flight History in a separate window. RT-FSA opens the filtered or unfiltered version of 

the Volpe Data Gate Flight History depending on what type you are authorized to view.  

Note: If the IGTD is missing for the flight used in the formation of the 

data gate link, a message that reads “ETMS data gate flight history 

link is unavailable due to a missing IGTD value” appears instead of 

the link. 
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Figure 24: Flight History for a Flight Controlled by a DAS Program 

Table 3 below describes the color scheme and what each color represents. To view a definition of 

each data field, position the mouse pointer over the column header and a description will pop-up.  

Table 3: FSA Flight History Color Scheme 

Color 
Description CTL_TYPE or CTD/CTA 

change 

Red (individual 

cell) 

A data anomaly has been detected. The 

data anomaly will be described at the top 

of the fight history. 

 

Brown CTD/CTA changed due to an FSM 

event, GAAP Delay, or an FA delay 

applied by ETMS. 

 

Blue CTD/CTA changed to an airline 

substitution or SCS 

 

Green The FAA has changed the control times 

using the ETMS EDCT Update utility, 

the flight record containing the transition 

will be colored green, as is currently 

done to indicate FAA updates to 

CTD/CTA. 

CTL_TYPE changes to ECR 

CTL_TYPE = UPD 

Periwinkle Bridged flight that falls within a fulfilled 

SCS Request 

CTL_TYPE changes to BRG 

Gray 

 

Flight is no longer listed in the ADL. If 

this is the last line in the Flight History 
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Report, the flight was dropped due to 

ETMS issues. If there is a gray line 

followed by another line, then the flight 

temporarily dropped out of the ADL and 

returned in a later ADL. Note: This does 

not apply to flights that drop out in the 

first ADL of each hour due to the ADL 

time roll over. 

The flight history for a flight on a prior day may also be viewed by FAA users. To do so, select 

the "Get past day" checkbox and enter the date of interest in the format shown in Figure 25. For 

prior day lookups, the destination must also be entered.  

 
Figure 25: Flight Lookup 

Note:  Airline users do not have access to historical flight lookups. 
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How To Copy, Save, and Print an FSA Report 

To copy, save, or print a report it is generally easiest to work with a text version of the report. 

Creating a Text Version of a report 

To generate a text version, select the Text Version link on the left hand side menu. A text version 

of the report appears. A text version of the compliance report is shown in Figure 26 below. 

 
Figure 26: Text Version of Compliance Report 

To Copy and Paste the text report 

From the Netscape Edit menu select Select All or alternatively use the shortcut keys CTL-A.  To 

highlight a portion of the report, left click and drag to highlight the section you want to copy. 

Right click the selection. 

1. Select Edit>Copy. 

2. Paste the copied text into a log or any other document. 

To Save the text report: 

1. From the browser, select File > Save As. 

2. Enter a file name. 

3. Select the location where you want to save the file. 

4. For the Save As Type, select ―Text File (*.txt)‖. 

5. Click Save. 



Doc ID:  FSA-SYS-TRN-001 Document Version 8.2 Date:  November 2010   

 
40 

To Print the text report: 

1. From the browser, select File > Print. 

2. Select the printer. 

3. Click OK. 

Note:  If you try to print a flight history Netscape will only print a 

single page width.  To print all columns of the flight history you will 

need to save it as a text file and print from another application such as 

Notepad, Word, or Excel. 
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Appendix A:  Questions and Answers 

Why does the number of slots not equal the requested Program Rate? 

This number of slots may not equal the program rate for several reasons:  

 Non Compliant Flights: Flights which have already arrived will not be included in a 

revision, even if the slot time assigned to the flight falls within the revision time 

period.  Furthermore, FSM does not look to see if slot times that fall within the 

revision time period were previously assigned to a flight that is not included in the 

revision.  Therefore it is possible that a slot time may be associated with multiple 

flights.  The end result is that the number of slots for a particular hour can exceed the 

program rate for an hour.  To illustrate, consider a flight with a slot time of 2130 with 

a 60-minute en-route time.  The flight was assigned a CTD of 2030 but departed an 

hour early at 1930 and arrived at 2030.  A revision is run at 2045 with a start time of 

2045.  Because the flight has already arrived it is not included in the revision and will 

keep the 2130 slot time assigned to it.  Assuming the program rate was 30 RBS++ 

creates 30 slots for the 2100 hour and creates a new 2130 slot, which is assigned to 

another flight.  Now two flights have a 2130 slot time. Even though FSM allocated 

30 slots in the revision, 31 slots now exist for the 2100 hour. 

 EDCT Updates: An EDCT update changes the flight‘s slot time; therefore if the slot 

is moved to a different hour the number of slots will no longer equal the requested 

program rate.  

 Ground Stops: Issuance of an FSM ground stop assigns all flights a CTD equal to 

the ground stop end time + 1 minute.  The affected flights slot times will also be 

updated to the new CTD + ETE.  This may dramatically redistribute slots.  

 Schedule Composition: Occasionally, FSM will not allocate as many slots as 

requested if it cannot assign any flights to an available slot due to the schedule 

composition.  This should very rarely occur - typically this only happens when the 

demand does not exceed the program rate by very much.  
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 Flights Are Dropped: Occasionally, flights get dropped from the ADL due to 

processing errors. The number of slots will be reduced by one for each controlled 

flight that has been dropped.  

For example, the 1500 hour of the OAK program on 09/22/2010 has a program rate 

of 30, but the number of slots is only 2.  See Figure 27 below. 

 
Figure 27: Slots not matching Program Rate 

I see a flight listed as extra demand that is arriving in the correct hour. Why is this 
flight being counted as extra demand? 

The only time you will see a flight, which is arriving in the correct hour, listed as extra demand is 

if its slot ID has a z suffix.  The z suffix indicates that the slot was not created by FSM when the 

program (or latest revision) was run and therefore it is considered to be extra demand.  This is an 

artifact of how FSM treats unscheduled flights that do not have a slot or FA delay in a stand-alone 

compression.  During compression FSM will create additional slots for these flights.  The slots 

that get created as a result of the compression process are given a slot ID with a Z suffix.  
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Appendix B: Real Time FSA Data Anomaly Checks 

Real-Time FSA currently makes the data checks listed below.  If any of the situations described 

below occur for a flight the flight will be flagged as having a data anomaly. 

 ETD < CTD with when ETD prefix =C.  This appears to be happening some when 

airlines send in Ltimes or Ptimes before their control times.  If Ltimes or Ptimes are 

before the CTD/CTA then ETD/ETA should not be remodeled to reflect the airline 

information. 

 Current ETA - Prior ETA > 20 hours and/or (b) max (ETA)-min (ETA)>20 hours. 

This is a comparison across records to see if the ETA gets bumped up by a large 

amount.  This usually means there was a data processing error (i.e. mismatch or date 

logic error.)   

 ETE <= 10 minutes where ETE=current ETA - current ETD.  

 (CTA - CTD) > 20 hours.  This check was added to capture the following scenario:  

FSM moves CTA before CTD then ETMS bumps up CTA by a day because ETMS 

logic assumes CTA must be greater than CTD. 

 The value of SGTD or SGTA changes.   This could indicate a mismatch of flight 

records in ETMS.   

 ETD changes after the ARTD has been received.   

 Final ETD<>ARTD. 

 ARTD disappears. 

 


